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Photo by Russell Trozera 
 
 

 

ColorMunki – Have your photos submitted for QuickPix, Members’ Night, or competitions not looked the way 

you expected? The problem is probably a difference in how your computer and the club projector display colors 

and brightness. You can fix this by calibrating your computer the same way our club calibrates our  projector – 

with the ColorMunki. Set up is simple and the calibration process only takes a few minutes. Contact Carl Detrow 

at csdetrow@verizon.net  to reserve the ColorMunki. 

 
__________________________________________________________________________________________ 

 
Want to learn more about your hobby?  

Click the link below to go to B&H learning Video Site: 

Click HERE

mailto:csdetrow@verizon.net
https://www.bhphotovideo.com/c/promotion/13486/optic-2017.html?utm_medium=Email%201654964&utm_campaign=Promotion&utm_source=WeeklySpecials%20170916&utm_content=Retail&utm_term=optic-2017
https://www.bhphotovideo.com/c/promotion/13486/optic-2017.html?utm_medium=Email%201654964&utm_campaign=Promotion&utm_source=WeeklySpecials%20170916&utm_content=Retail&utm_term=optic-2017
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President’s Message – Russell Trozera 

 

Dear Redlands Camera Club Members 

 

The Redlands Camera Club has a lot of outstanding photographers. I did 

not realize the number of our members who had career’s in the 

photography industry.  

This month we will have our Fall Competition. One of the perks of being 

president or competition chair is I get to see the images before everyone 

else.  

I have to say there are some really nice images. Our club should be 

proud of the quality of the images they produce. I hope that everyone will tune in to the competition 

on the 21st of September at 7 PM on Zoom.  

The program committee is still looking for more ideas on program topics for the rest of the year. 

Please let Dave Garner or myself know what subjects you would like to hear about. The feedback that 

I have been getting from our zoom meetings is very positive. We want to make them more exciting 

and valuable. Please let us know what you would like to hear about. 

Summer is still here and it has been hot. Fall is just around the corner. I have been making some plans 

to see fall colors around our part of the country.  The Bishop Creek area is an excellent spot to see fall 

colors and is not too far away.  

On the back side of Big Bear along Highway 38, near Heart Bar Camp Ground there are willows that 

start to turn color in October. The leaves start turning color because winter is coming and the 

temperatures are dropping.  

A good website to see how the fall colors are progressing is https://smokymountains.com/fall-foliage-

map/   

It shows 2019 fall progression. You can also keep a watch on the nightly temperatures to be an 

indication how soon the colors might be changing. 

 Have fun and be safe! 

 

 

 

 

 

 

 

 

Photo  
by  

Russell Trozera  
 

 

 

 

 

 

 

 

 

 

https://smokymountains.com/fall-foliage-map/
https://smokymountains.com/fall-foliage-map/
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Vice President/Chairman Program Committee – Dave Garner 
 

Upcoming Programs 
 

September 7, 2020 Labor Day weekend no Zoom meeting 

September 21, 2020 Fall Competition 

 _________________________________________________________________________ 

 

 

  

Photo by Wayne “Woody” Wood 
 
 

               Photo by Rick Strobaugh 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
                                                         Photo by Stephanie Billings 



~ 4 ~ 
 

Competition Chair – Carl Detrow 
 

 

Competition for September 2020 
 
 

The Fall competition is underway. It will be held the second Monday in 

September, September 21, 2020.  

 

That’s different from our competitions usually held on the first Monday, but we 

decided not to have it on Labor Day.  

 

The submission period for this competition was extended to three weeks, but because of a bit of 

miscommunication on the part of the competition chair, there was a short gap where the entry page 

came down off the website. It was restored by some quick work by Debra, so I hope everyone was 

able to submit their images.  

 

We received nearly 50 beautiful images, so this competition will be a good one. We are working on 

preparations to hold it online. Watch your e-mail for details and check the website for the Zoom link as it 

gets closer.  

__________________________________________________________________________________________ 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
                     Photo by John Williams 

 

 

 

 

 

 

 

 

 
 
 
 
 
    

                                                                   Photo by Bruce Bonnett 
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In light of our upcoming Photo Competition, here are screen captures of our Best 
of Show Winners in order of wins from the last 10 years. 
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Member Recognitions 
 

 

Christine Pence had a “Photo of the Day” win on Imaging Resource with her stunning 

image “Bear Snuggle”. 

 

Congratulations Christine! 
 

 

 
 
 

If you have a photo competition win and would like to share it with the club members please send me 

the details and I will include it in the next Photogram. Seeing outstanding images not only brings 

recognition to the creator but encourages others to try harder in their own photography. 

Send them to mailto:debbiedsd.dorothy@gmail.com 

_____________________________________________________________________________ 

 

 

 

 
 
 
 
 
 
 
 
 
                                                                                                     Photo by John Williams 

mailto:debbiedsd.dorothy@gmail.com
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RCC Photo Blog – Stan Fry 

 
Redlands Camera Club Group Members Only 

Are you a member of the Redlands Camera Club? Come and join our new Members Only 
group where you can share images, tips, tricks, offer support or insights, ask questions and 
interact with other members without all the other distractions of an open group. Please read 
the rules and you must be a Redlands Camera Club member to join! 

We are up to 70 users and almost 1,100 images on the RCC Photo Blog.  

If you do not already have an account, send an e-mail to signup@rccphotoblog.com and we will get you set up. 

The blog is a great place to get input on your images. Other Members’ images can help you find some 

inspiration (and perhaps some motivation). 

We are working on the image color issue for some images.  When images are submitted they are resized to fit 

different screens.  In this process, they are desaturated a bit.  We don’t know the cause of the problem yet, but 

are working on a solution. 

 

I got tired of sifting through photography sites and blogs trying to find useful learning material.  In response, I 

created pbdigest.com – a curated (sort of) collection of photography articles from over 100 photography blogs.  

Given that this site helps me keep track of useful learning resources, I though club members may benefit too.  I  

would also be interested in any feedback you might have.  Thanks for taking a look and I hope the site is helpful 

to you. 

 
_________________________________________________________  

 

 
 
 
 
 
 
                                         
 
 
             
 
 
 
 
                                                   Photo by Stephanie Billings 
 
 
 
 
 
 
 
 

                    Photo by Rick Strobaugh 
 
 
 
 
                                                                                                                           Photo by Wayne “Woody” Wood 

 

https://www.facebook.com/groups/2521924061368053/?__xts__%5B0%5D=68.ARCMAALkoRBiKV1gSiQlz6tIFwP9hhA0vDx7b_cNQPtCWsrnFMzm43yvMG4XGCLGF8UwN6ingQLl8pIRVLlFRKC-t81BV15gmBA8fWuptNsT85AI8BJu5BBvlHdKIOPq2ehadlUiqXAE25HwAqNDrKmKcreKuQkyCDhfU2Um_PIjoNfzm-yMmxlb27M_n1MbD0VOrODP5y4kS-ZhpNbY2LxPmu3_rYsXSOvN0WdeXQl7Q-2T7MzbQ_OLg2lLhCYKDuqHemuPluGDQDo-X5EDmnmwkePxpl6cQa4AZrRYCNuceCLnaXdyOfA-jhJQJgHljsQCnUyWfkuT29YQzMFPQQcc4w&__tn__=HH-R
http://www.pbdigest.com/
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Announcements 
 

New – Personal Lightroom Coaching with John Williams 
 

Contact John Williams for some over-the-shoulder coaching in photo editing, a great way to learn. Using 

your selected images, John will work with you at your level to improve your understanding of key tools and 

techniques to make the most of your photos. John is a regular contributor of articles on Lightroom and 

Photoshop to the RCC Photogram. Reach John at jhwr@earthlink.net or talk to him at our meetings.  

 

RCC Members: Unique opportunity to make a difference 
Frank Peele, Education/Workshops Chair 

 

Museum of Redlands 

This newly-established museum needs quality photography of items in its collection, and has asked RCC 

for support. This sounds like a win-win situation, both for the museum and for our members who want 

to develop skills in “product” photography. I envision a workshop to teach the fundamentals, and one or 

more shooting sessions to get into creating great images for the museum’s use. If you’re interested in 

being part of this service to the community, or just want to find out more about the opportunity, shoot 

me an email: educationworkshopsrcc@gmail.com  Thanks, Frank 

____________________________________________________________________________________________________________ 

Film cameras and Lenses Needed  
 
A group of photo-enthusiasts at Riverside Community College needs FILM cameras and lenses to use in 

their studies. If you have such equipment you’re willing to donate to a worthy cause, please contact RCC 

member Constance St Jean and let her know what you have. Contact her by email at 
constancestjean@gmail.com 

_____________________________________________________________________________________________________________ 

 

 

Photo by Ann Kramer 
 
 
 
 
 

mailto:jhwr@earthlink.net
mailto:educationworkshopsrcc@gmail.com
mailto:constancestjean@gmail.com
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Here’s What I Think!  

 

This article covers different Adobe Photoshop/Lightroomtips and 

techniques.  The views expressed in this article are those of the author and 

do not necessarily reflect the views of Redlands Camera Club. 

By John Williams 

Need help?  If you have any questions about processing an image using Adobe Lightroom 

or Photoshop, email me at jhwr@earthlink.net (for RCC members only) and I will try to 

assist you. 

EDITING YOUR PHOTOS 

 Overall Adjustment advice:  Generally it’s best to perform as many of your adjustments as possible with 
the original raw capture rather than later in your workflow.  Use Lightroom Classic (or Adobe Camera 

Raw) for adjusting the raw capture.  Then use Photoshop to do your targeted adjustments and image 

cleanup work. 

 Demosaicing process: The term "demosaicing" refers to the process of calculating the "missing" color 
values for each pixel in a raw capture, due to the fact that most raw captures only record a single color 

value for each pixel in an image. It’s recommended to apply most adjustments in Lightroom Classic or 

Adobe Camera Raw.  Note that the adjustments you apply with your raw-processing software are actually 
applied after the "demosaicing" process.  This means that your adjustments are applied after the raw 

capture has been converted to actual pixel values. Demosaicing algorithm is a digital image process used 

to reconstruct a full color image from incomplete color samples output from an image sensor overlaid with 

a Color Filter Array (CFA). It is also known as CFA interpolation or color reconstruction.  Many modern 
digital cameras save images in a raw format allowing you to demosaic the images using 

software(Lightroom, Adobe Camera Raw), rather than using the camera's built-in firmware. 

 Some reasons to use Photoshop over Lightroom Classic:  

1. Retouching Photos: Most image cleanup work should be done in Photoshop because it has more 

powerful and effective tools such as Content-Aware technology.  For minor dust spots, it’s 

recommended to use Lightroom Classic. 

2. Targeted Adjustments:  Since Photoshop uses selections and layer masks, you get a greater degree of 

control when making adjustments to specific areas. 

3. Filters:  Photoshop has a variety of creative filters and effects that are not available in Lightroom 

Classic. 

PHOTOSHOP TIPS 

 Useful tips: 

1. Quickly change the brush size and hardness: On Windows, depress the 

Alt key + drag your mouse Right to decrease the brush size or drag right to 

increase the brush size.  To decrease/ increase the brush hardness, drag the 

mouse up/down. 

2. Crop Tool Content-Aware option:  When you straighten or rotate an 

image and release your mouse button, you will generally notice a white 

empty space around the photo edge(s).  To automatically fill the empty 

space, check the Content-Aware  checkbox in the Options bar.  

 

3. Toolbar and Tool Switch:   

 Wherever you see a little arrow on the bottom right of a tool in the Photoshop toolbar, it means 

there are other “hidden” tool choices. Hidden tools are accessed by clicking and holding on a tool 

listed in the toolbar. As you hold, a fly-out set of tools will appear giving you access to all of the 

hidden tools under that particular tool.  In the example below, you can see that by clicking and 

holding on the Spot Healing Brush tool, the hidden Healing Brush Tool, Patch Tool and Content-

Aware Move Tool becomes available.  Note that the shortcut is displayed next to the tool name. 

mailto:jhwr@earthlink.net
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 To cycle through tools that share a keyboard shortcut, press and hold the Shift key in conjunction 
with the keyboard shortcut that corresponds to your desired tool until that tool is selected. 

 The tool that's initially displayed in each spot in the toolbar is known as the default tool and the 

first one listed in the flyout menu.  After choosing a different toll in the flyout menu, the Toolbar 

will no longer display the default tool.  Instead it will display the new tool you selected.  To reset 

you Toolbar to the default tools, select the Move tool and in the Options bar right-click the Move 

Tool icon while holding down the Ctrl key.  In the popup menu select Reset All Tools. 

 To cycle through all the tool in a group, depress the shortcut key (J in the example above) 

repeatedly.  This option can be turned off by selecting Edit>Preferences>General and checking 

Use Shift Key for Tool Switch. 

4. Alt key and layers:   

 Zoom:  If you hold down the Alt key and click on a layer, it will zoom and expand the layer to full 

view. 

 Moving and Duplicating Layer Masks:.  Hold down the Alt key and click-hold on the Mask to 

create a copy of the mask.  Then drag the Mask thumbnail to another layer to create a copy.  

 Holding the Alt key on an Layer:  When you hold down the Alt key on a Layer it will duplicate 

the Layer.  Then you can drag the duplicated Layer to another location in the Layers Panel. 

 Add a black Mask:  If you hold down the Alt key and click on the Layer Mask icon at the bottom 

of the Layers panel, it will add a black (hide mode) Mask. 

5. Change Layer Preview Thumbnail size:   

 Click on the small four horizontal lined icon in the top right corner of the Layers panel. 

 

 In the popup menus select Panel Options (near end of popup menu).This opens the Layers Panel 

Options dialog box, and at the very top of the panel are the Thumbnail Size choices.  You can 

choose None, Small, Medium or Large (recommended) size. 

 Note you can right-click anywhere in the empty space below the bottom layer in the Layers panel, 

and choose either Small, Medium, Large, or No Thumbnails from the popup menu. 

6. Toggling the Visibility of Layers: 

 Clicking the eye icon next to any layer on the Layers panel will hide/show the layer.  

 Holding the Alt key and clicking on the eye visibility icon will hide/show all other layers. 

 Show both of options above as menus:  Right-click the Layer visibility (eye) icon and a popup 

menu will appear to choose either Hide this layer or Show/Hide all other layers (see figure 

below). 

 

 Toggle The Visibility of Multiple Layers at once: You can click-and-drag up/down on multiple 

adjacent eye icons to toggle the visibility of multiple layers off/on. 

LIGHTROOM TIPS 
Two tips using the Graduated Filter: 

 Mask Overlay:  You can see the parts of the image that are affected by a filter by showing the Mask 

Overlay. While the filter is active, pressing the “O” key will show the Mask Overlay or checking the 

Show Selected Mask Overlay box in the toolbar..  The default Mask Overlay color is red; however, you 

can change the color to green, white or black by depressing the Shift+O keys or choosing 

Tools>Adjustment Mask Overlay. 
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 Add a color wash/tint:  When using a local adjustment (Graduated Filter, Radial Filter, or Adjustment 
Brush), you can apply a color wash/tint over the local adjustment area which does not obscure details in 

your photograph. It’s laid over the filter in addition to the effects created by whichever sliders you choose 

to adjust. 

 To select a color, depress the Color Effect icon (icon with a black “X” (see left figure below).  Then do 

one of the following methods to select a color: 

1. Select a color from the color picker field: To select a color, first reposition you mouse over the 

color field (mouse turns into an eyedropper), then move to a color you want to select and click.  To 

adjust the saturation, move the slider. 

2. Select color from the photo:  Click in the color picker (mouse turn into an eyedropper), then 

continue to hold the mouse down and drag over the image area to choose a color from the photo.  

3. Select a color from the computer screen: Arrange your windows so that Lightroom workspace is 

not filling your whole screen. Have Lightroom workspace on one side and the browser window or 

whatever you want to sample from, open on the other side of your computer screen. Then click in 

the color picker (mouse will turn into an eyedropper), then continue to hold the mouse down and 

drag your mouse over to the area you want to sample. 

 

4. Note:  After applying a color wash/tint, you can reset and remove the effect by double-clicking the 

word Color (see left figure above) or setting the slider to the far left (saturation value of 0). 

Flip the area that is being adjusted. 

 Mask Overlay: To see the area that is being adjusted depress the O key or check the Show Selected 

Mask Overlay checkbox in the Toolbar. 

 Draw the graduated filter by clicking and dragging from the point where you want the gradient to begin 

and when you've reach the point you want the gradient to end, release the mouse.  As you do, three lines 

will appear across your image.  The two outer lines represent the distance of the gradient transition, while 

the middle line determines the angle of the gradient.  The top line represent where 100% of the affect is 

applied.  The center line with the round black circle represents where 50% of the affect is applied and the 

bottom line represents the point where the effect ends (0%). 

 When you click and drag the filter, the top line will remain in place and the other two lines will continue 
to separate as you drag you cursor.  However, if you hold down the Alt key and click on the photo, the 

center line with the control point will remain in place and the other two lines will separate further from the 

center line as you drag your cursor.  This technique is useful since the center line remains stationary 

allowing you to place exactly where you want most of the adjustment to take place 

 Flip Adjustment Area: After dragging out a Radial Filter, you can flip the area being adjusted by 

depressing the apostrophe (‘) key.  Also you can hold down the Alt key and raise the lower line above 

the pin.  The Alt key prevents the pin line from moving.  

 
How do you move Lightroom to a new computer: 

 Backup:  You need to make sure that all of the essentials are backed up—the catalogs, photos, 
preferences, presets, profiles, defaults, plug-ins and any other related files. 
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1. The Catalog: our catalog(s) have a “*.lrcat” extension.  They hold all of the information about your 

photos, including all of the work you’ve done on the photos within Lightroom, so it’s essential that 

you include your catalog in your backups.  To find your Catalog select the Edit menu (Windows) / 

Lightroom menu (Mac) and select Catalog Settings.  In the General tab, it will tell you the name and 

location of your current catalog and the Show button will open to that location in Explorer (Windows) 

/ Finder (Mac). 

NOTE:  Let Lightroom run its own Catalog backups too. Catalog corruption is rare, but user error 

(e.g. accidentally changing a setting on lots of photos) is very common. You never know when you 

may need to restore some settings from an older copy of the catalog. Lightroom’s backup tool zips the 

catalog and places it in a dated subfolder, so you can always go “back in time”. 

2. Previews: The previews are stored in the same location as the catalog.  It’s a folder (Windows) / 

package file (Mac) with “Previews.lrdata” at the end of the name if you deleted your original photos 

accidentally, they may be the only copy left.  Previews should be rebuilt on demand as long as you 

have the original photos, and they do take up a lot of space. 

3. Catalog Backups:  To check the current location, open the Catalog Settings dialog, which you’ll find 
under Edit menu (Windows) / Lightroom menu (Mac).  Lightroom never deletes your older catalog 

backups. You can delete older backups yourself to free additional hard drive space. It’s recommend 

keeping at least the most recent backups, in addition to some slightly older ones (e.g., 1 month, 6 

months, 1 year), just in case you later discover you’ve accidentally overwritten some settings or 

removed some photos from your catalog. 

4. Your Photos:  Remember, the photos aren’t “in” Lightroom, but are stored as normal files on your 

hard drive that you designate.  Make sure you backup your working files using their current folder 

structure, in case you ever have to restore a backup.  Don’t forget, you’ll want to include your edited 

files (i.e. the ones created by Edit in Photoshop or other external editors) in your backups too.  

5. Presets & Templates:  You’ll want to back up your presets, whether they’re ones you’ve downloaded 

or presets that you’ve created yourself. That includes Develop presets, Slideshow, Book, Print and 

Web templates, Metadata presets, Export presets, etc.  To find them, go to  Edit>Preferences and 

select the Presets tab.  Clicking the Show Lightroom Presets Folder (LR 1-7.4) button / Show All 

Other Lightroom Presets button (LR 7.5+) will open an Explorer/Finder window directly to their 

location. 

6. Settings shared with Camera Raw — Default Settings, Point Curves, Custom Camera & Lens 

Profiles: Some settings are stored in a shared location, where they can be shared with Camera Raw 

hosted by Photoshop or Elements. They include your Develop Presets (LR Classic 7.3 and later), 

Develop default settings, lens profile default settings, custom point curves and any custom camera or 

lens profiles that you’ve created or downloaded. They’re stored at: 

Windows—C: \ Users \ [your username] \ AppData \ Roaming \ Adobe \ CameraRaw \ 

Mac—Macintosh HD / Users / [your username] / Library / Application Support / Adobe / CameraRaw 

/ 

7. Plug-ins you’ve installed: You may have downloaded Lightroom plug-ins, for example, On1, Export 

plug-ins, Publish Services, custom web galleries, and so forth. You can probably download those 

again from the developer, but it’s worth backing them up to be on the safe side. To find them, go to 

File menu > Plug-in Manager and on each non-standard plug-in, check the current path, as shown 

below. Don’t forget to write down your serial numbers or registration codes at the sa me time! 

8. Your Preferences:  You may want to back up your Preferences file. That includes last used catalogs, 

last used settings, view options, FTP settings for uploading web galleries, some plug-in settings, etc. 

Windows—C: \ Users \ [your username] \ AppData \ Roaming \ Adobe \ Lightroom \ Preferences \ 

Lightroom Classic CC 7 Preferences.agprefs  

Mac—Macintosh HD / Users / [your username] / Library / Preferences / 

com.adobe.LightroomClassicCC7.plist 

 Install Lightroom on your new computer: 

1. You can install Adobe applications on more than one computer, activate them (sign in) on two, but use 
them on only one computer at a time. To activate apps on a third machine, you’ll need to deactivate 

(sign out) on the computer you are deactivating computers first. 

You also can see your plan and deactivate your old computer by going to the following web site:  

https://account.adobe.com/plans 

2. Install Lightroom on your new computer:  If you’re a subscriber, you can sign in and start the 

download from https://creativecloud.adobe.com/apps/all/desktop 

3. Transfer the files:  Transfer the files—the catalog, the photos, preferences and so forth—and place 

them in the same locations as they were on the old computer. Most people use an external hard drive 

for the transfer, or a wired network connection.  

4. Open the catalog on the new computer:  Double-click on the *.lrcat catalog file to open it and 

Lightroom will automatically open. 

https://account.adobe.com/plans
https://creativecloud.adobe.com/apps/all/desktop
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5. Relink missing files: You might find that there are Question Marks all over the folders or there are 
icons in the corners of the thumbnails. Right-click on the parent folder and choose Find Missing 

Folder from the context-sensitive menu, and navigate to the new location of that folder. 

6. Reload any disabled plug-ins: Finally, you might find your plug-ins need reloading as the locations 

may have changed in the move. Go to File menu > Plug-in Manager and check whether all of the plug-

ins have green circles. If any plug-ins are incorrectly loaded or missing, add them again at their new 

locations. 

 

_________________________________________ 
 
 
 

 
 
 

 

 

 
 
 
 
 
 
 
 
 
 
 

                               Photo by Debra Dorothy 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                                                                              
                                                                                                 Photo by Ann Kramer 

 



~ 18 ~ 
 

Photogram Editor – Debra Dorothy 

A Note from The Photogram Editor 
 

 

The theme for the October Photogram is “Redlands”. 

 

Please send your images to me by Sept. 25
th
 to have one included in the October 

Photogram. 

mailto:debbiedsd.dorothy@gmail.com 

 

 

 

  

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 

 

Redlands Camera Club P.O. Box 7261 Redlands Ca 92375 

 

http://www.redlandscameraclub.org/ 
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